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1  GENERAL DESCRIPTION 
1.1 Easy Entry provides a highly adaptable online entry application for hosting any 

event where the entries can be judged on the basis of uploaded data and images. 
The client (the event host, you) has full control over all of the characteristics of 
the event, within the very broad limits of the application. 

1.2 The person who signs up is regarded as the Principal for the business.  The name, 
phone, email and mailing address entered during creation of the account will be 
used by Easy Entry for all business correspondence. Normal operating contacts 
will use the phone and email addresses entered during client set up. 

1.3 In addition to supporting entrants, Easy Entry supports three types of client users, 
managers, administrators (admin), and jurors, each with password-protected 
access to relevant parts of the application as determined by you. All users must 
create an account with their name, email address, a password and, in most cases, 
their full mailing address. 

1.4 Initially, a manager sets up the application by entering basic client information 
using the client setup form. Some of this information is displayed as page headers, 
some determines to whom errors are reported and some control how entry fees 
and purchases are paid and recorded. Managers can also designate administrators 
(admin) with full access except to the client setup form. In this Guide, the term 
admin encompasses managers. 

1.5 An event is created by filling out a form that determines the characteristics of the 
event including the type of event, geographic area, number of entries, entry fees, 
whether accepted artwork should be for sale and under what circumstances, and 
other details and limitations. There is no limit on the number of events you can 
create. 

1.6 Easy Entry accommodates individual artwork and body of work events. Body of 
work events are usually used to select artists for solo or small group exhibits; 
those exhibits can be displayed online by entering the works into an individual 
artwork event established for that exhibit. 

1.7 Entrants submit title, medium, size, price and jpeg images of artworks; for prints 
and casts, they can enter the edition size. 

1.8 There can be up to five jurors for individual artwork events and up to ten jurors 
for body of work events. Jurors independently score the individual artwork or 
body of work online from zero to five. When jurying is completed, admin marks 
the artwork or artist as accepted based on the total of the jurors’ scores. 

1.9 Admin can call up screens of information and statistics related to an event or 
download various spreadsheets, including lists designed for notifying accepted 
and unaccepted artists. 

1.10 There are five online displays of artwork, each with its own purpose: 
1.9.1 The artwork entry page displays each entered artwork to the entrant; 

the entrant can log in to view or edit the entered artwork while the 
event is open for entry. 

1.9.2 When an event closes to entry, the juror can log in to score the artwork 
in the juror’s gallery. 
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1.9.3 From the time an event is open for entry until the exhibit closes, 
individuals who have been granted access by admin can log in to view 
a gallery of all entered artwork. 

1.9.4 After artwork has been marked accepted, admin may open a public 
online gallery of accepted artwork for viewing or for sale. 

1.9.5 When the exhibit ends, the accepted artwork can be displayed in public 
online galleries of past events or be hidden from display; unaccepted 
images are deleted. 

1.10 This GUIDE is written for you, the client. It may be shared in whole or in part 
with anyone provided the copyright is clearly stated or displayed. 
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2  CLIENT SETUP 
2.1 During the sign up process, the person responsible for conducting business on 

behalf of the client (the Principal) will have created an account that includes the 
address to which invoices and remittances will be sent. On signing up, the 
Principal receives a client identification code (ClientID) and a list of URLs and 
has full managerial access. Logging in to the client setup form (Fig 1) the 
business information necessary for use of the entry system can be completed or 
edited. This chapter describes the forms found in client setup. 

2.2 View or print a list of your URLs provides URLs that include your client ID and 
can be used to send entrants, jurors and others to appropriate locations in the 
application. The clientID has no security implications but, if lost or forgotten, can 
only be replaced or recalled by Easy Entry. Appendix A has more information 
about each URL. 

2.3 Your current deposit amount displays the current amount of your deposit and 
allows you to add to the deposit to ensure the amount will cover the expected 
number of entrants. The deposit is reduced by $2 for each entrant and entry is 
closed if it reaches zero. You will receive a reminder email if it is less than $100 
but a popular event can blow through that pretty quickly. Any unused deposit is 
fully refundable. 

2.4 Your PayPal Account allows you to enter the primary PayPal email, the business 
ID and the Payment Data Transfer (PDT) token necessary for fee payments to be 
automatically recorded in the database. These entries must be kept current and 
correct or payments will not be recorded and you will need to enter them 
manually based on PayPal’s emails to you. If payment is not recorded, the entered 
artwork will not be shown to the juror(s).  See 10.4. 

2.5 Record basic business information provides the information used by the 
application. Some of the information is displayed as page elements or links, some 
determine to whom errors are reported and some control how fees are paid and 
recorded. Each entry on this form is explained below. You can change your 
information at any time, keeping in mind that the web rewards consistency. 
2.5.1 Business Name: The name you want to appear as a default header on 

most pages where the event name is not the default. It is also used in 
some of the messages displayed to users. Up to 50 characters are 
allowed but good web practice says, “Shorter is Better.” The Business 
Name may be replaced by a logo; see 2.5.9. 

2.5.2 Business Location is used when the entry area is set for client’s state 
only. 

2.5.3 State Sales Tax is used to inform artwork buyers of the amount of tax 
that will be added to the purchase price by PayPal. This tax rate must 
also be set in your PayPal account for tax to be collected; see 10.5.  

2.5.4 Public Contact title, phone and email: These provide a way for entrants 
or the viewing public to contact the event host for assistance. They 
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appear in various combinations on appropriate pages and in certain 
messages displayed to the user if errors occur. 

2.5.5 CCEmail 1 and CCEmail 2: Optional email addresses entered here will 
receive copies of most error emails, the exceptions being relatively 
routine issues that the event manager should be able to address. 

2.5.6 Gallery Contact allows contacts to be specified for the sales/viewing 
gallery independently from the Public Contacts for general information  
requests for assistance. These gallery contacts may be different or the 
same as the Public Contacts. If nothing is entered here, no contact 
information appears in the online gallery, which might be viewed by 
PayPal as a violation of their Account User Agreement. 

2.5.7 Allow Direct Payment:  You can elect to allow payment of entry fees 
by mailed check or phoned credit card or both. This alternative will be 
displayed next to the Pay Now button on the artwork entry page. The 
event manager must record these payments manually to ensure the 
artworks are displayed to the juror. This is done using “Review or 
Change an entrant's fees and 'Fee Paid' status” in the Admin manage 
page. 

2.5.8 Home URL: This is the full web address of your primary web site 
(e.g., http://clientsite.com). Log Out and HOME links in the 
application pages point to this URL. If you do not have a web site, a 
“Thank you” message appears. 

2.5.9 URL for Terms of Entry & URL for Terms of Purchase: Relevant 
pages will display a link to the Terms applicable to the event. For 
Terms of Entry, this might be a copy of the prospectus. Whenever 
artwork can be purchased online, it is desirable to have written Terms 
of Purchase in order to avoid disappointed buyers or disputes. During 
creation of each event, you have the option of posting the Terms on 
your website or on the Easy Entry Online site. 
2.5.9.1 If the Terms are posted on your web site, a default URL must 

be entered into the client setup form. Doing this for multiple 
events requires that you enter a URL that links to a page on 
your website which is a list of links to event-specific Terms 
for several events.  

2.5.9.2 You can post the Terms on Easy Entry’s web site by 
uploading a PDF copy of the Terms. You can upload default 
Terms plus any number of event-specific Terms. Default 
Terms apply to all events except those for which event-
specific Terms are uploaded. (See 3.3.9) 

2.5.9.3 If you elect not to have written Terms of Purchase, the sales 
gallery will display the gallery contact phone and email 
entered as described in 2.5.6. 
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2.5.10 Add or Replace Logo: Your logo must be a png or gif image, 
preferably with a transparent background because it will appear on 
both light and dark backgrounds. Space constraints suggest the width 
should not be not much less than the height nor more  than 4 times the 
height. We recommend that the shortest dimension of the logo image 
be at least 200 pixels. 

2.6 Assign or remove a manager allows a manager to assign managerial access to 
others. Only a manager can create or edit the client setup or assign or remove 
managerial access. Managers have access to all parts of the Easy Entry 
application. Administrators (admin) have access to all parts except client 
setup.  The assignment of admin and other levels of access is addressed in the 
next chapter (3.8). 
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3  EVENT SETUP 
3.1 Admin login options are setup (Fig 2):and manage. (Fig 3):Setup encompasses 

relatively infrequent activities having broad effect, including the creation of 
events and the assignment of administrative access. Manage includes all the 
routine activities related to managing events. Only managers and administrators 
have access to the Setup and Manage pages. The Manage page is addressed in 
Chapter 4 

3.2 Review the names and characteristics of your events: This allows a review of the 
names of events that have been created and the characteristics of each. This is also 
a gateway to modifying the characteristics of a closed event. Event names must be 
unique; to use a name more than once, it will need to be distinguished by adding, 
for example, a year, month or serial number. 

3.3 Set up a new event: Name an event and define its characteristics  
Please note the limitation that accepting global entries (247 countries) is 
incompatible with requiring full contact information because many countries 
don’t use conventional address formats. Our design assumption is that global 
entries will be accepted mainly for events with online-only exhibits or that full 
contact and shipping information can be obtained from accepted artists by email. 
3.3.1 Type of event 

- Jurying of individual artworks 
- Artists selected based on body of work 

3.3.2 Information requirements 
- Require full contact information  
- Require name, city, country and email only 

3.3.3 Important Dates 
When present, The Open to Entry and Closed to Entry dates will be 
used to open and close the event to artwork entry. The close date will 
also be used to send automatic reminders to artists who have entered 
an event but not yet paid the fee three days before the event will be 
closed to entry. The dates can be changed at any time (see 3.4)  

3.3.4 Geographical area for entry 
- Client’s state only 
- Contiguous 48 states: Excludes Alaska and Hawaii 
- Domestic US: 50 states + District of Columbia + Puerto Rico 
- NAFTA: Domestic US + Canada + Mexico 
- Any unembargoed country. (247 countries) 
- Regional: Selected US states - District of Columbia - Puerto Rico 

3.3.5 Number of Entries and Fees 
You must set both the total number of entries allowed for the event 
and the number covered under the base fee; they may be the same. 
- Maximum total number of entries allowed 
- Number of entries covered by the base fee 



8 

- Base fee 
- Extra artwork fee (each artwork not covered by the base fee) 

3.3.6 Maximum Dimensions 
State in the Terms of Entry whether size includes the frame or 
supporting structure. A depth dimension entered by the artist will 
signify the artwork is 3-D. For 2-D events, leaving 3-D depth at zero 
will prevent 3-D entries.  
- 2-D Height and 2-D Width 
- 3-D Height, 3-D Width and 3-D Depth (if zero, 3-D not allowed) 

3.3.7 Terms of Entry (entry conditions or restrictions) 
Default Terms will apply to all events except those for which event-
specific Terms have been uploaded. 
- Use default Terms on client’s site if URL entered in client setup 
- Use default terms uploaded previously or with this submission 
- Use Terms uploaded with this submission for this event only.  

3.3.8 Pricing Conditions for the Artist 
This controls the pricing information the artist is allowed to enter. 
- Sale is required; Price on Request is not allowed 
- Sale is required; Price on Request is allowed 
- Sale is optional; Price on Request is not allowed 
- Sale is optional; Price on Request is allowed 
- No price entry; no price display: Shipping area must be zero. 
NOTE: Allowing a price is independent of whether you will offer sales 
of the artwork. 

3.3.9 Terms of Purchase 
The Terms of Purchase can be posted on your site or they can be 
uploaded here as a PDF file. A link to your Terms will then appear in 
the online sales galleries. 
- Use Terms posted on client site if link URL in client setup 
- Use default Terms uploaded previously or with this submission 
- Use Terms uploaded with this submission for this event only. 

3.3.10 Geographical Area for Shipping Purchased Artwork  
0. Artwork will not be sold. 
1.  To be agreed: Displays only your sales contacts. 
2.  Client’s state only 
3.  Contiguous 48 United States and District of Columbia 
4.  Domestic US: 50 states + District of Columbia + Puerto Rico. 
5.  PayPal Calculation: Areas and costs in Terms of Purchase. 
6.  Pickup Required  Location and time in Terms of Purchase 

3.3.11 Shipping and Insurance Charges 
For Areas 0 and 1, both zero or blank; entries will not be used. 
For Areas 2 – 4, both are required. 
For Area 5, insurance rate is required; shipping must be zero or blank. 
For Area 6, both must be zero or blank. 
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- Shipping flat rate in whole dollars. 
- Insurance rate as a percentage of artwork price 
NOTE: Before using the three above settings (3.3.9 – 3.3.11) the 
details provided in Chapters 10 and 11 and Appendix C should be 
reviewed. 
 

3.4 Change Event Dates: This allows the event open and close dates to be changed at 
any time. (They can also be overridden manually in admin manage.) 

3.5 Get list of Event Numbers: Displays a list of all current and past events showing 
name, status and the eventNbr (a unique identifier for each event). All or part of 
the list can be copied and pasted into a text document for convenient access. 

3.6 Restore a Past or Hidden event to Closed status: The Past or Hidden status 
essentially hides an event from admin and is expected to be permanent. (See 4.2) 
This option restores access in case of unusual circumstances. 

3.7 Display current administrators: Allows a check on whether the list of authorized 
administrators is correct and current. The display includes the contactNbr (a 
unique identifier for each account) and the name and type of access for each 
individual. As with all list displays on screen, the list can be copied and pasted 
into a text editor for printing, storage or sharing. 

3.8 Assign, Change or Remove Administrator Access: This allows three types of 
access to be assigned or removed: 
- Admin: Access to all password-protected pages except client setup 
- Sales: Access to the on-site sales catalog and to the Image Gallery 
- Image Gallery: Access to view all current entries (Chapter 7) 

3.9 Download CSV (MS Excel) Lists: This allows seven types of comprehensive lists 
to be downloaded as comma separated value (csv) files, which will open natively 
in MS Excel: 
- All entrants and the number of events each entrant entered. 
- All events and all entrants into each event with accepted entrants identified. 
- All buyers and the number of orders and artworks purchased. 
- All sales with event, artwork title and buyer identified for each artwork sold. 
- All jurors and the number of events juried. 
- All jurors and the events they juried. 
- Tourists who have never entered artwork and the number of events logged into. 
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4  EVENT MANAGEMENT 
4.1 Admin login options are setup (Fig 2):and manage. (Fig 3): Setup encompasses 

relatively infrequent activities having broad effect. Manage includes all the 
routine activities related to managing individual events. Only managers and 
administrators have access to the Setup and Manage pages. Setup is addressed in 
Chapter 3. The options available in the Manage page are described here. 

4.2 Change an event’s status: Admin can mark an event Open, Closed, Past or 
Hidden. Artists can only enter an Open event and jurors can only view a Closed 
event. Events marked Past will be displayed in the public archive gallery of past 
events. Events marked Past or Hide are no longer displayed in the various admin 
selection lists. Marking an event Past or Hidden deletes all unaccepted images, the 
records of entries that were not shown to the juror and the records of people who 
logged in to and event but did not enter an artwork. 

4.3 Review or change an entrant’s fees and ‘Fee Paid’ status: Admin can review the 
number of entries and fee status of an artist, increase or decrease the amount paid, 
increase or decrease the amount due or mark all of an artist’s artworks as paid or 
unpaid. 

4.4 Change an artwork’s ‘Show to Juror’ status: Block individual artwork images 
from viewing by the juror after the artist has paid the entry fee, for example, when 
an artist cannot deliver the artwork because it has been damaged or sold. This 
action is reversible. 

4.5 Assume the identity of an entrant: This puts admin in the artwork entry page with 
the identity of the artist. Admin can perform all functions allowed to the artist, 
i.e., enter, delete and edit the artist’s artworks. This option is available when the 
event is open or closed. 

4.6 Display Current Jurors: Displays jurors assigned to each current event. 
4.7 Assign or Remove a juror for an event: The juror must have an account and 

password. Up to five jurors may be designated for individual artwork events; up 
to ten jurors for body of work events. No one should be assigned who will not 
score artwork because it dilutes the averages used to mark artwork accepted. (For 
viewing entries. use the Image Gallery instead.) 

4.8 Assume the identity of a juror: This puts admin into an assigned juror’s gallery 
where admin can act for the juror to review or revise scores. 

4.9 Display statistics for individual artwork events: This displays the number of 
entered, paid and accepted entrants and artworks and the total fee revenue to date. 
It also displays the number of paid entrants by state and the total number of  
“tourists,” i.e., people with accounts who log in but do not enter artwork. 

4.10 Get List of Your Event Numbers: Displays a list of all current and past events 
showing name, status and eventNbr for each event. The list can be copied to a text 
file. 
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4.11 Mark Juried Entries Accepted: Based on the jurors’ scores, admin can mark 
individual artworks as accepted or, for body of work events, mark artists as 
accepted. (Body of work artworks are not displayed in the public viewing 
galleries. See Chapter 7.) After marking accepted artworks, accepted artistc can 
be informed that their accepted works can be seen in the artists’ gallery. (see 7.5) 
Alternatively, admin can download a csv (Excel) file listing accepted artists and 
artworks for notifying the artists by email or mail.  

4.12 Set Catalog and Tag No. For Accepted Artwork: (Optional) Sets the catalog 
numbers for accepted artworks based on alphabetical order. When set, these 
numbers will be displayed in the viewing galleries and included in the 
downloaded files for preparing the catalog and wall tags for an event. After the 
catalog preparation has started, the tag numbers should not be reset or changed. If 
an artwork needs to be removed, changing it to unaccepted will simply leave a 
gap in the sequence of numbers. (For late additions, see 4.14.) 

4.13 Add Tag No(s) for Artwork Accepted Late: When artwork is added to the accepted 
list for an event after tag numbers have been assigned and catalog preparation for 
that event has started, running this option on the event will assign tag numbers to 
the added artwork by adding 1 to the highest number already assigned. This has 
no effect on the existing tag numbers so the artwork can be manually added at the 
end of the catalog. 

4.14 Display an online gallery of accepted entries in a current event: Admin can 
display accepted artwork online for public viewing or for sale, or remove an event 
from display. (When an event is no longer current, its status should be marked 
Past for display in the archive gallery, or Hidden to prevent display.  See 4.2) 

4.15 Display data for individual artwork events: Admin can choose to display artist 
and artwork information for artworks that are Entered, Accepted or Not Accepted, 
or choose to display complete contact information for artists that are Entered, 
Accepted, Not Accepted or Not Paid. (See also 4.16.) 

4.16 Download CSV (MS Excel) Files for individual artwork exhibits: These files can 
be filed, shared or used as mailing lists. The download choices are: 
— All Referral Sources 
And for a selected event: 
— Accepted Artists with [the titles of] Accepted Artworks 
— Paid Artists Not Accepted 
— Unpaid Entrants 
— Paid Entrants 
— Buyer’s Purchases (if sales are recorded in the database) 
— Artist’s Sales “ 
— Order Financials “ 

4.17 Download Accepted Images and Related Data: Downloaded images are the 
original images uploaded by the artist; the image file name correlates with the 
filename column in the corresponding data file. The data file also includes the 
artist's name, city and state and the artwork's title, media, size and price. Price = 1 
means Price on Request; Price = 0 means Not for Sale. On a Mac, you can sort the 
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data file on contactNbr to achieve the same sort order as the folder of images. In 
Windows, filename sorting varies with version. Consult MS Support. 

4.18 Download Catalog and Wall Tag Data: This provides a tabulated text file 
prepared for input to the process described in Appendix B. See also 4.16. 

4.19 View & Print Shipping List: This displays and/or prints a receiving–shipping list 
for artworks to be delivered for exhibition. It includes contact data for the artist 
and thumbnail images of the artwork. Downloading this amount of data to the 
printer is controlled by the printing speed. When writing to a PDF, allow at least 
one minute per hundred artworks before trying to open the PDF and do not leave 
the browser page until the PDF has been successfully opened; if opened too soon, 
a “damaged file’ message may appear but that does not usually interrupt the 
download process. Try again after a few more minutes. 

4.20 Display or Download data for body of work events: This displays in a browser or 
downloads as a csv (Excel) file, the total score, contactNbr, email address and 
name of each entrant in a body of work event. 

4.21 Remove artist from body of work event: This deletes the artist's statement, juror 
scores, image data and images for the selected artist and event. This saves storage 
space and avoids displaying already accepted artists to jurors during long term 
competitions. A record of the artist's participation in the exhibit and acceptance 
status is retained in the database and included in event statistics. 

4.22 Display or Download Artwork Sales Data: For the requested purchase order(s), 
this provides the order number, date and time of purchase, eventNbr, buyer name 
and email, artwork title and price, tax, shipping and insurance costs and the 
amount paid. Downloads are csv (Excel) files. Displays require use of the 
browser’s Back button to return to admin. 
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5  ACCOUNTS 
5.1 Everyone who logs in to the Easy Entry application must have an account with an 

email address and password. Entrants into an event that does not require full 
contact information must also provide city and country. All other accounts must 
include a complete address and primary phone number. Entrants with an Easy 
Entry account can enter any client’s events without needing to create a new 
account. 

5.2 The event entry login page displays links to create or update an account. Entrants 
in an event not requiring complete address information fill out a shorter account 
form. After an entrant creates or updates the account, a link to return to the event 
entry login page is displayed. If you have provided a logo, it may be displayed at 
the top of the account forms; see 5.3.  

5.3 You can send others (e.g., admin, jurors) to create or update an account by 
providing them with a URL or link to the proper form as indicated in Appendix A. 
If the URL or link includes the myid extension and you have provided a logo, 
your logo will appear at the top of the account form; otherwise the Easy Entry 
logo is displayed. Anyone using a URL or link without evtid will be required to 
provide a full address and a primary phone number.  

5.4 If an individual has more than one account, it dilutes historical information by 
separating the separate accounts’ records of participation. For this reason, links to 
update the account or recover a forgotten password are included on most login 
pages. 

5.5 If someone with an account tries to create a new account with the same name and 
email address, the existing record will be updated with any new information 
submitted. However, there is no protection against a second account if the email 
address or name is different, e.g., Thomas becomes Tom. 
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6  ARTWORK ENTRY 
6.1 The URL or link to the event login page must include myid to identify the client 

and evtid to identify the event. The login page includes links to create or update 
and account and to restore a forgotten password but its main purpose is to 
identify the entrant arriving to enter artworks and the event being entered. When 
logging in, the entrant is required to accept the Terms of Entry and provided with 
a link to view or download the Terms. This form also invites the entrant to 
identify how they heard about the event. 

6.2 After logging in, the artist enters the artwork entry page (Fig 4) which displays 
images of the entered artwork. The sidebar displays the number of artworks 
already entered, the maximum allowed, the total entry fee, the amount paid to 
date and the balance due. When a fee is due, a PayPal payment button is 
displayed.  

6.3 Clicking on submit a new artwork displays a form for submitting the title, media, 
size and at least one jpeg image for each entry; a second image is allowed. A 
price is allowed or required depending on the settings for the event. An artist can 
enter, edit, replace or delete artworks at any time in one or more login sessions 
while an event is Open to entry. Entered artworks appear on the artwork entry 
page as thumbnail images with the related data. 

6.4 If the artist pays and returns to enter additional artwork, a proportionate 
additional fee is charged based on the total number of entries and the fee already 
paid. If artworks are deleted, the fee for the current session is reduced 
appropriately but there is no credit for fees already paid. (If you want to offer 
refunds, they will have to be handled separately.) 

6.5 The file size for artwork images is limited to 5 MB. The image size is limited to 
20 megapixels (pixel width times pixel height). The prospectus could, and 
perhaps should, recommend an image size 3000 pixels on the longest side and 
note the overall limit of 20 Megapixels. The recommended size ensures a full 
screen image for the juror with minimal upload time. 

6.6 Paying the entry fee through PayPal using the Pay Now button provides 
automatic recording of the payment in the database and resets the artwork status 
from “Pending” to “Show to Juror.” If payment by check or phoned credit card, 
or by any other means is allowed, admin must manually record such payments 
using the option provided for that purpose (See 4.3). 

6.7 The artwork entry page for body of work events has an additional field for an 
artist’s statement of up to 1000 characters. The artist’s statement appears on the 
jurors’ page for body of work exhibits.  
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7  ONLINE IMAGE GALLERIES 
7.1 The seven image viewing galleries are described below. All except Gallery A are 

similar in layout and all display each artwork entry as one or two images with the 
relevant information and controls for the particular gallery. In all galleries, 
clicking on a thumbnail image opens the image in its original size. 

7.2 Image Gallery allows admin and other assigned individuals to view all entered 
artworks from the time an event opens for entry until it is marked Past or Hidden. 
It displays the title, media, size, artist name and, conditionally, the artist’s city, 
state and country. It also shows the payment status and the date and time of entry. 
Users can sort on last name or entry time. 

7.3 Juror Displays display the artwork title, media and size but not the artist’s name. 
It allows individual artwork jurors to sort on image ID, which groups an artist’s 
entries together, or on current score and to display pages of 100 entries each to 
reduce reload time when the number of entries is large. Body of work displays 
also include the artist’s statement. Jurors can score individual artworks or an 
artist’s body of work from 0 to 5 with 5 being highest. Multiple juror’s scores are 
averaged. (Chapters 8 & 9) 

7.4 Accept Gallery allows admin to mark artworks accepted based on jurors’ scores. 
Individual entries can be marked or entries can be grouped according to jurors’ 
scores and marked as a group. 

7.5 Artists’ Gallery is designed for artists to view and identify the artworks that have 
been accepted for an event. It is ordered by the artists’ names. 

7.6 Gallery A can be set for viewing only or for sales of accepted individual 
artworks. The URL or link to it must include the evtid. The gallery (Fig ) displays 
the images in a grid format and lists the artist’s name, the artwork’s title, media, 
size, price and, when available, edition size. See Chapter 11 for more details. 

7.7 Gallery B can be set for viewing only or for sales of accepted individual 
artworks. If the URL or link to it does not include the evtid, a list of available 
events is displayed. The gallery displays the images in a linear format and lists 
the artist’s name, city and state and the artwork’s title, media, size, price and, 
when available, edition size, awards won and a link to the artist’s web site. See 
Chapter 11 for more details on sales.  

7.8 On-Site Sales Catalog allows assigned sales staff to record on-site or phoned 
sales directly into the database. This will allow the sales and financial data to be 
later downloaded as spreadsheet (csv) file. Using this to record on-site sales is 
crucial if sales are offered online because it immediately records the SOLD status 
of the artwork, preventing it from being bought again online. (Chapter 11) 

7.9 Archive Gallery displays two optional gallery views of accepted images from 
events marked Past. Easy Entry will maintain the Archive Gallery until storage 
limitations require that we truncate the maintenance period or charge a fee for 
extended maintenance. We do not foresee this happening for several years and 
will provide ample advance notice to clients before making any change. 
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8  JURYING INDIVIDUAL ARTWORK 
8.1 There are two juror displays; different in design and style, they each have 

advantages that may appeal to jurors. Consequently, both Juror Display 1 and 
Juror Display 2 are available and switching between them is quick and 
convenient. Both affect the same database so each is updated automatically when 
switching back and forth. Neither of the displays show the artist’s name. 

8.2 Both displays list the entry data in this order; the entry place number and the total 
number in the current list (e.g., No. 3 of 462), the image ID, the artwork title, 
media, size and the scoring options. The images are 250 pixel wide thumbnails of 
the submitted originals. The artist’s name is not shown. 
 
Juror Display 1: 

8.3 Controls in the sidebar allow the juror to sort on image ID or on the current 
scores. The juror can also elect to “Display All” artworks or “Display Pages” of 
100 artworks each. The former offers a way to scroll among all entries. The latter 
will reload quicker after scoring an artwork or changing the sort selection when 
the number of entries is very large. The sidebar also includes links to a Juror 
Guide, to Juror Display 2 and to Log Out. 

8.4 If Display 1 is sorted on image ID, each artist’s entries will be grouped together 
because the image ID lists the entrant ID followed by the submission number. 

8.5 Clicking on an image will display the full size image in a new window or tab. 
The full size images provided by the artists may or may not fill the window. If 
they are larger than the window, most browsers will shrink to fit the window as a 
default setting. A few browsers require the user to select that feature. 
 
Juror Display 2: 

8.6 Display 2 lists the images in columns where the image at the top of column 2 
follows the bottom image in column 1 and so on. This is similar to the layout of 
galleryA (Fig. 8.1). The order of the images is by score, subsorted by entrant ID. 
Clicking on an image will hover a larger image over the page. Click on the X or 
outside the image to dismiss it. 

8.7 The navigation bar at the top of the page includes the following options: 

• Lowest score to view shows only images with scores equal to or greater than 
the score entered; the default is zero. This display is sorted on score, then 
entrant. 

• View all of an artist’s entries shows the entries of the artist whose ID is 
entered. 

• Juror Display 1 switches back to that display. 
• Log Out allows log out from this page. If Display 1 is also open its window 

should be closed. 
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For Both Displays 
8.8 From one to five jurors can be assigned to an individual artwork event. A juror 

can log out and log back in to score in multiple sessions. The sum of all jurors’ 
scores is recalculated each time an artwork is scored. 

8.9 If a single juror is to select the exhibit, asking for the selected works to be scored 
5 will simplify marking of the accepted work as a group. 

8.10 When jurying is completed, admin can mark the artwork accepted, either 
individually (Fig 5.2) or in groups (Fig 5.3), based on the juror’s scores. (See 
4.11) 

8.11 After the artwork has been marked accepted, it will appear in the artist’s gallery 
for viewing by the accepted artists. (See 7.5) 

8.12 Although the opportunity to submit a second image was intended mainly for 
3-D work, some 2-D artists submit details as a second image. A few artists may 
mistakenly submit an image of their second artwork as a second image for the 
first artwork before submitting it again as a new entry. Jurors can readily 
recognize and ignore these mistakes when they occur. (Admin may want to 
assume the identity of the entrant to remove these spurious images before setting 
the event for public display.) 
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9  JURYING A BODY OF WORK 
9.1 A body of work event involves from one to ten jurors evaluating one or more 

artists based on a collection of each artist’s artwork. This is usually done to select 
artists for a solo or small group exhibition, which may or may not include the 
artwork submitted for the body of work event. Body of work events may be of 
short duration when selecting artists for a specific exhibit or of long duration if 
selecting candidates for continuing exhibits in a specific space. 

9.2 The jurors’ gallery does not display the artist’s name. The main section (Fig 6.1) 
of the juror's display includes the artist’s statement at the top, followed by the 
scoring panel and the artwork images representing the artist’s body of work. 
Listed to the left of the images are the image ID, the artwork title, media, and 
size. If there is a fee for entering the body of work event, the payment status of 
the artist is also displayed. 

9.3 Clicking on an image will display the full size image in a new window or tab. 
The full size images provided by the artists may or may not fill the window. If 
they are larger than the window, most browsers will shrink to fit the window as a 
default setting. A few browsers require the user to select that feature. 

9.4 Scores from zero to five may be assigned; higher is better. Jurors can log out and 
log back in to score in multiple sessions. The sum of all jurors’ scores is 
recalculated each time an artwork is scored. 

9.5 Artists are marked as accepted by admin based on the sum of all jurors’ scores. 
9.6 Body of work images are displayed only in the jurors’ gallery. If the body of work 

review results in an artist being selected for a solo or small group exhibit, that 
exhibit can displayed online by setting it up as an individual artworks event, 
entering the artworks to be exhibited and accepting all of them. 

9.7 When jurying is completed, admin can mark the artwork accepted (Fig 6.2) based 
on the juror’s scores. (See 4.11) 
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10  PAYPAL PAYMENTS 
10.1 Easy Entry is set up to automatically record entry fee payments made through 

PayPal using PayPal’s Instant Payment Notification (IPN) and Payment Data 
Transfer (PDT) features. This involves two-way communication between the 
application and PayPal. The Pay Now buttons send information to PayPal for use 
in charging the payer and recording the transaction. PayPal then returns 
information about the payment back to Easy Entry in the form of an IPN, which 
is used to record the entries as paid and the amount paid by the entrant. PayPal 
also emails the payer and the account holder with payment information. Current 
information about payments is available to the event manager through both, 
PayPal’s transaction summary page and Easy Entry’s admin download functions. 

10.2 After payment, PayPal sends the payer back to the Easy Entry site (unless the 
payer closes the PayPal window) where the payer is thanked for the payment and 
told that they will receive an emailed receipt from PayPal. The page also displays 
the amount paid, the event to which the payment applied and, for entrants, a link 
inviting the entrant to log in to confirm that his or her artwork status has been 
changed from Pending to Show to Juror. On rare occasions, the payer will return 
to the Easy Entry site before the IPN can record the payment. On those occasions, 
the payer will see a message recommending they confirm the status of their 
payment with the event manager. Admin can confirm the status using the admin 
option, “Review or change an entrant’s fees and Fee Paid status.” The Fee Paid 
status should not be changed unless an email reporting the payment has been 
received from PayPal. 

10.3 In order for Easy Entry to perform the automatic tasks described above, you must 
activate certain features in PayPal’s Selling Tools; Auto Return, Payment Data 
Transfer (PDT) and Instant Payment Notification (IPN) must be turned ON and 
the default URLs for PDT and IPN must be entered on the respective pages. 
Appendix C provides more details on how to find and set the required features. 

10.4 In addition, three identifiers from your PayPal account must be entered into the 
client setup: the Primary PayPal Email and the PayPal Business ID (Merchant 
Account ID) and the Return Token (PDT Identity Token) (see 2.4) These 
identifiers are sent to PayPal only for entry fee or artwork sales payments to 
identify the recipient of the payment. Where to find these on the PayPal site is 
addressed in Appendix C. Failure to properly enter these identifiers will result in 
the need to manually record each payment using the PayPal emails as your 
source. 

10.5 Easy Entry is not aware of any state that imposes sales tax on entry fees; sales 
taxes do apply to sales of artwork. If you offer online sales, you must set your 
state’s sales tax rate in client setup and in your PayPal account in order for the 
tax to be applied when the payer takes delivery in your state. Easy Entry displays 
the tax amount to the buyer and sets the tax when the artwork is to be picked up. 
(See Appendix C for details.) 
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11  SALES 
11.1 Between the time the artworks are marked accepted and the exhibit is closed, the 

images of the accepted artworks can be displayed in an online gallery for sales 
online under the conditions selected during event setup (Chapter 3) or for viewing 
only. The images are also displayed in the on-site catalog where gallery staff can 
record on-site sales or phoned sales. The on-site catalog also has a reset button 
that allows staff to change the status of artwork to Sale Pending, Sold or For Sale. 

11.2 When artwork is available for sale online, it is critically important that any on-site 
sale be recorded using the on-site catalog or, at the very least, reset the artwork’s 
status to Sold. Otherwise, the artwork will remain for sale online with the risk that 
a unique artwork will be sold twice. Resetting to Sold does not record the 
transaction details rendering later download of financial data unreliable. 

11.3 Artwork sale requires resolution of three particular issues: First, as mentioned 
above, most artworks are unique; when one is sold, it must be promptly removed 
from sale to prevent it being sold twice. Second is the need to determine whether 
and how much sales tax should be applied. Third, if shipping is involved, shipping 
costs for items of varied size, weight and destination need to be determined and 
displayed for the online buyer.  

11.4 Sale Status: In both, the online galleries and the on-site catalog, when the buyer’s 
contact information is recorded, the artwork is marked Sale Pending and is 
temporarily not available for sale to others. When the payment is completed and 
recorded, the artwork is marked SOLD and is permanently unavailable for sale. If 
the buyer abandons the purchase before paying, the artwork is automatically put 
back on sale after a one hour delay. As noted above, gallery staff can also set or 
reset an artwork’s sale status at any time. 

11.5 Sales Tax: Only a few states do not collect sales tax. If an item is picked up at the 
gallery or delivered inside your state, you are likely required to collect sales tax. 
This requires that you set the tax rate in your PayPal account so that the correct 
amount of tax can be added by PayPal depending on the shipping address 
provided by the buyer. The client setup form also allows the tax rate to be entered 
there so the amount can be displayed to the buyer in advance. 

11.6 Shipment Insurance: The cost of shipping insurance is typically proportional to 
the product value but may be applied incrementally. The percent of value entered 
during event setup is applied to each artwork in an order and totaled for the 
shipment. 

11.7 Shipping Cost: You have two options for setting the shipping cost. First, set a flat 
rate that will apply to each artwork and select one of three geographical areas for 
which the rate applies. The second option is to use PayPal’s method of setting the 
shipping cost for individual regions, states or territories (See Appendix C.) For 
either option, shipping charges are applied to each artwork on the assumption they 
will be shipped separately. 
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11.8 The following shipping data from 2018 are approximate but provide a sense of 
the variability in shipping costs. For a package 40” X 40” x 4” weighing 5 
pounds, the USPS and UPS costs to ship from a mid-Atlantic coast city were:  
 
To 50 miles away USPS - $67 UPS - $39 
To Vancouver WA USPS - $175 UPS - $95 
To Anchorage AK USPS - $175 UPS - $200 
To San Juan PR USPS - $145 UPS - $200 
 
Larger packages are not accepted by USPS and UPS applies a “volume weight” 
formula that is based on package dimensions.  

11.9 Two other options that avoid setting shipping costs in advance are, a) to require 
sold artwork to be picked up from the exhibit at times and places specified in the 
Terms of Purchase posted online, or b) to invite online gallery visitors to phone 
or email your sales representative for sales information. These are options 1 and 6 
respectively in event setup. 
  
Online Viewing or Sales Galleries 

11.10 There are two designs, designated as galleryA (Fig 8.1) and galleryB (Fig 9.1), 
each of which can be set for public viewing only or for sales. Both present the 
image(s) of the artwork, the artist’s name, and the title, size, media and price of 
the artwork. For prints and casts, the edition size is included. GalleryB also lists 
the artist’s city and state and any awards won for the artwork. GalleryA allows 
one artwork per order. GalleryB allows more than one artwork per order. Both 
galleries include links for contacting the sales representatives by email or phone. 

11.11 The sales galleries will display a link to your Terms of Purchase and certain 
information consistent with your settings for the event, e.g., flat rates for shipping 
and insurance and the shipping area within which they apply, or a statement that 
PayPal will set the rates prior to payment or that pickup is required. 

11.12 You should state clearly in the Terms of Purchase all conditions related to the 
sales. For example, whether artwork will be delivered during an exhibit or only 
when the exhibit is taken down, the area to which artwork can be shipped, 
conditions for refund, if any, and, if artwork will not be shipped, where and when 
it must be picked up. You can choose to have the Terms of Purchase located on 
your web site and enter the URL for its location during the event setup, or upload 
a PDF copy for display on Easy Entry’s site. (See 3.3.9) 

11.13 Clicking on the Buy Now button opens a form (Fig 8.2) for the buyer to enter 
name, email and phone, to select pickup or shipping and to purchase insurance or 
accept responsibility. When this form is submitted, the artwork is marked Sale 
Pending and the one hour time limit described in 11.3 applies. In Gallery B, a 
receipt (Fig 9.3) is displayed that can be printed by the buyer; it contains details 
not provided by the emailed PayPal receipt. 

11.14 The full shipping address is supplied by PayPal in a communication that allows 
the artwork to be marked SOLD and the transaction details to be recorded in the 
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database for your retrieval. As mentioned elsewhere but important enough to be 
mentioned again: Payments through PayPal will only be possible if you enter your 
three PayPal identifiers in client setup and set your state sales tax rate in your 
PayPal account. Setting the sales tax rate also in client setup will inform the buyer 
in advance of the amount of tax PayPal will add for pickup or in-state delivery. 

11.15 If online sales are provided, Easy Entry recommends setting your PayPal account 
to require confirmed addresses. See Appendix C for details. 
 
On-site Sales Catalog 

11.16 IMPORTANT: If online sales are offered, it is essential that any on-site sale be 
recorded through the on-site sales catalog (Fig 7.1) or that its status be set to Sold 
by using the Reset Status button. (See 11.2) Using the reset button means that 
downloaded financial data will be incomplete. 

11.17 The on-site sales catalog displays the shipping area and the flat rate shipping and 
insurance costs for that area. It also displays the tax applicable for in-state 
delivery or pickup. All of these values can be overridden by admin to 
accommodate different conditions. For pickup, the shipping and insurance values 
would be set to zero and the tax applied; for in-state shipping, all default values 
would apply; for out of state delivery, the tax would be set to zero and the 
shipping charges applied. When the sale is recorded in this way, a receipt can be 
printed for the buyer. As with the online sales, the amounts paid for the artwork, 
tax and shipping are recorded in the database for your retrieval. 

11.18 When the Place Order button is clicked, the on-site sales form (Fig 7.2) appears 
for recording buyer information and whether the artwork will be shipped or 
picked up from the exhibit by the buyer. On submission of this form, the sale id 
recorded in the database and  a receipt (Fig 7.3) is displayed that can be printed 
for the buyer. 

11.19 The Reset Status button allows admin to mark an artwork as SOLD or Sale 
Pending, or to put back on sale an artwork that has been marked Pending or 
SOLD. This can be used to recover from an abandoned on-site sale or to correct 
an incorrect sale status resulting from a recording error for an online or on-site 
transaction. Using the button to reflect a sale not recorded using the on-site 
catalog will render the financial information available for download unreliable. 

11.20 This is a good place to mention that the sale of an artwork for which an edition is 
posted removes the artwork from sale by marking it SOLD on the assumption 
that additional copies are unlikely to be readily available. If this is not true, the 
artwork can be placed on sale again by using the Reset Status button. 
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APPENDIX A 

APPLICATION URL LIST 
[clientID] is a unique client identifier provided to the client upon sign up along with 
a complete list of these URLs that include the clientID. 
[event#] is the unique event number assigned when an event is set up. It is required 
in the URLs for entrant and juror logins and for links to galleryA. 
 
CLIENT SETUP – requires manager access for login. 
http://easyentryonline.com/clientsetup/index.php?myid=[clientID] 
This form records the client’s choices regarding online display, contacts by the 
public and payment transactions. It also allows designation of additional managers. 
Changes are expected to be infrequent but certain data are critical and must be kept 
current. 
 
ADMIN LOGIN –requires admin access for login. 
http://easyentryonline.com/EEO/admin/index.php?myid=[clientID] 
This provides access to forms for setting up an event or for routine management of 
events. (Admin also has access to all of the password-protected pages below. 
 
CREATE ACCOUNT 
http://easyentryonline.com/EEO/accounts/create-an-account.php 
 
UPDATE ACCOUNT LOGIN – myid will display your logo but is optional. 
http://easyentryonline.com/EEO/accounts/acctstart.php?myid=[clientID] 
 
ENTRANT LOGIN – requires an event number. 
http://easyentryonline.com/EEO/entry/index.php?myid=[clientID]&evtid=[event#]  
 
IMAGE GALLERY LOGIN – requires assigned access for login. 
http://easyentryonline.com/EEO/artistgallery.php?myid=[clientID  
This gallery displays all entered artworks in exhibits not marked Past or Hidden.  
 
JUROR LOGIN – requires event number and assigned access for login. 
http://easyentryonline.com/EEO/juror/index.php?myid=[clientID]&evtid=[event#]  
Body of Work exhibits only display in the jurors’ gallery and for admin. 
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ARTISTS’ GALLERY  requires event number 
http://easyentryonline.com/EEO/juror/index.php?myid=[clientID]&evtid=[event#] 
Allows artists accepted into an individual artworks event to view all artworks 
accepted for the event and identify which of their artworks must be delivered for the 
exhibit. 
 
GALLERY A – requires event number 
http://easyentryonline.com/EEO/galleryA/index.php?myid=[clientID]&evtid=[event
#] 
This gallery displays the accepted images in current events. It can be set for viewing 
only or for sales. See Chapter 11 for sales information. 
 
GALLERY B – event number is optional 
http://easyentryonline.com/EEO/galleryB/index.php?myid=[clientID]&evtid=[event
#] 
This gallery displays the accepted images in current events. It can be set for viewing 
only or for sales. If the event number is included, it displays the gallery for that 
event; otherwise it displays a list of available events. See Chapter 11 for sales 
information. 
 
ARCHIVE GALLERY 
http://easyentryonline.com/EEO/archive/index.php?myid=[clientID] 
This gallery displays the accepted images for each event that has been marked Past. 
 
ON-SITE SALES ADMIN LOGIN – requires assigned access for login. 
http://easyentryonline.com/EEO/salesadmin/index.php?myid=[clientID] 
Current events are listed for selection at login. The selected event is displayed as a 
catalog of accepted artworks and their sale status. Sales made on-site or by phone 
can be recorded and receipts printed. It allows sales tax and shipping costs to be 
adjusted as appropriate for the sale conditions. It also includes a button for resetting 
an artwork’s sale status to Sold, Sale Pending or For Sale. 
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APPENDIX B 

CREATING A CATALOG AND WALL TAGS 
Introduction 
Our intent is to provide the data needed to develop a basic catalog of accepted artwork in 
a form that does not constrain the catalog format. We decided on a comma separated 
value (csv) file format for the download because it offers a great degree of flexibility in 
the way it can be processed. The data can be selectively merged into a catalog formatted 
in inDesign or in Word. If the data is not to be merged but imported directly into a word 
processor, Excel offers a variety of powerful tools for manipulating the data into the 
desired form prior to the import. 
Merging the data into inDesign or Word requires familiarity with the tools offered in each 
application. This appendix will offer some tips and examples but the user is encouraged 
to use the relevant application’s documentation to learn about these tools. The time spent 
on learning will be returned many times by the time saved in preparing future catalogs. 
If you have a need for data that is collected by the Easy Entry Online application but not 
included in the download, please let us know. 
There is one technical issue that can be addressed here because it is relevant for all of the 
methods discussed below. When the downloaded file is opened, the first column will 
either be serially numbered, indicating that tag numbers were assigned by admin or it will 
be all zeros; we will assume zeros for our example. Because we want our sample catalog 
to be numbered, we’ll use Excel’s serial numbering tool to assign numbers as part of the 
Introduction. Type 1 in the A2 cell (under TagID) and put 2 in the A3 cell; select the two 
cells and drag the lower right corner of A3 down to the last row with data. All rows are 
now serially numbered as they would have been if admin had assigned tag numbers. 
Merging Data in Word 
If you create your catalog in Word, you should consider creating it using mail merge, 
which may be Word’s most misleading name for a function. In addition to printing 
customized letters and envelopes, you can create name tags, a directory or, in our case, a 
catalog. By creating a catalog main document using merge fields in Word, the time 
required to produce catalogs can be greatly reduced. A merge field stands in place of a 
column in the data source, which may be any one of several tabulated formats, including 
an Excel file. Upon merging, each row in the data source replaces corresponding merge 
fields in the main document. The following description is for Word 2016 for Mac; other 
versions may have different locations for the menus and commands, but the commands 
and methods exist in all versions. Use the Help menu to get details for your version. 
First open the downloaded catalog.csv file in Excel and save it as an Excel workbook. 
Then open a new document in Word: In the document menu bar select Mailings, which 
displays the merge menu. Select Start Mail Merge and select the broadest category—in 
our case, that is Directory. Within the document that appears, establish the relationship 
with the data source by choosing Select Recipients and Use an Existing List to open the 
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Excel file of catalog data. Then select Write & Insert Fields > Insert Merge Field from 
the menu to see a list of the column headings in the Excel file from which to select the 
appropriate column, say TagID. This will place a merge field called TagID into your 
document. Now type a period, then a tab after TagID. Return to Insert Merge Field to 
select Attribution. Follow Attribution with two spaces and an open parentheses, Insert 
Merge Field City_State and follow it with a close parentheses. The Preview of the marge 
will depend on the entrants to your event but will look like this: 
1. John Brown  (Madison, WI) 
 
Move to a new line and Insert Merge Field for Title, then a new line for Media followed 
by a tab, then $ and a merge field for Price. What you see in the preview is: 
1. John Brown..(Madison, WI) 
Naked Fields in Winter 
Oil on fiber board $200 
Notice that we have entered a new line (SHIFT-RETURN) for all except the last line, 
which is ended with a new paragraph (RETURN). The reason is so that the entire entry 
can then be formatted as a paragraph for tabs, paragraph spacing, etc.  
One issue that is not treated very clearly in Word’s Help menu is how to format or style 
the merge fields. (Any formatting in the data source is ignored.) For example, if you want 
the artist’s name in bold: you must first turn on bold (CMD-B), then insert the merge 
field followed by a space, then turn off bold (CMD-B). The same applies to using italic or 
any other character format. Likewise for styling; go to the Home menu to turn on the 
Styles Pane, which will stay with you when you return to the Mailings menu. then select 
the style to turn it on, insert the merge field followed by a space, then turn the style off by 
selecting a different style, e.g., plain or normal. Deleting what we have done so far and 
repeating the process following these rules to apply bold to the artist name, italic to the 
title and after resetting tabs, results in: 
1. John Brown..(Madison, WI) 
Naked Fields in Winter 
Oil on fiber board $200 
We will now select Finish and Merge in the Mailings menu and Edit individual 
documents. The result is a new, editable Word document with a single column of entries 
formatted as in the main document with each entry having the values taken from a row in 
the data source document. You can either use this as the base for starting your catalog, or 
copy and paste the column(s) into a Word template for your catalog. 
If you plan to use the same catalog format consistently, save the main document, and you 
will need only to establish a connection between it and the next downloaded catalog.csv 
file to produce your next catalog. 
Tip: Applying styles rather than using keyboard commands to apply character format 
offers greater flexibility is dealing with the final document as modifying the styles will 
affect the entire document, which is not true for the character formatting. This also 
applies if the Word text is placed in inDesign. 
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Merging Data in inDesign 
Inserting merge fields in inDesign is similar but some of the commands and options are 
labeled differently and there are more options for layout. In earlier versions, the data 
merge function was found in Window > Automation; it is currently in Window > 
Utilities. The essential steps are the same as for Word: establish a connection with the 
data source so that a list of field options (column headers) can be presented for selection; 
place the merge field into the document; preview the results; create the merged 
document. However, there are a number of process differences due to the flexible layout 
options available in inDesign. 
A text box must be created into which the merge field(s) can be placed along with any 
supplemental text. One or more merge fields can be placed in a text box with multiple 
text boxes then arranged into the desired layout or all of the merge fields can be placed 
and arranged in a single text box, similar to the arrangement of the merge fields in a 
single paragraph in Word. 
Character styles can be applied to a text box, affecting all text within it, including the 
merge fields, or styles can be applied to individual merge fields or blocks of text within a 
text box. 
Tabs and indents apply to individual text boxes. 
The variability of line length, particularly for titles and media, makes it difficult to 
anticipate the required size of the text box(es). This would likely make some post-merge 
editing of the merged document necessary. Depending on your typical catalog data this 
could make merging and editing in Word and placing the resulting column into inDesign 
more appealing.  
Editing a Text File 
If you cannot or choose not to merge, you can modify the data using Excel’s tools before 
saving it as a tab-delimited file to be opened in Word or another word processor. Excel’s 
font styling will not be preserved but Word’s vertical block feature can be used to style 
individual columns, as we will describe below. 
NOTE: What follows seems tedious, but once learned the process as described here can 
be done in about 20 minutes and is far, far less tedious than typing the entire catalog. 
You can perform the following operations on the downloaded csv file or an Excel file. 
The first step is to delete any unnecessary columns from the file. For our example, we 
have deleted all except the following columns: 
TagID Attribution City_State Title Media Price 
1 Fred Brown Madison, WI Naked Fields in Winter Oil on fiber board 200 
Our first step is to add two decimal places to the TagID numbers, the use of which will be 
explained below. Select the TagID column, then Format > Cells > Number > 2 decimal 
places.  
Now we will use Excel’s CONCAT function to format the City_State column. First we 
need to insert a new column to hold the results of our concatenation. Insert a new column 
after the City_State column .( In our version of Excel, we select the Title column, then 
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Insert > columns._ Type a heading for the new column, such as City_State2. We want to 
put parentheses around the city-state text and two spaces in front of the result. In cell D2 
under City_State2, type  =CONCAT(“  (“,D2,”)”). Notice the quotes around the added 
text but not around the cell reference and the three elements are separated by commas. 
Pressing return shows the result. Select D2 and drag it down to the last row with data, 
then press CTRL-D or use Edit > Fill > Down. The format will be applied to all rows. 
We no longer need the original City_State but, if we delete it now, we’ll mess up the 
City_State2 column which is dependent on it. We can cure that by selecting and copying 
all of the cells in column D and using Edit > Paste Special > Text to replace the formulas 
in column D with the text. The values are  no longer dependent on City_State so that 
column can now be deleted. 
If you want a $ on your prices, select the price column and use Format > Cells > Number 
> Currency > zero decimal places and Symbol $. Now we can SAVE AS a Tab delimited 
text file and open the saved text file in Word. 
Upon opening the file in Word, it is best to SAVE AS a Word document. Then stretch the 
window to full screen width; select File > Page setup > Page size > Manage Custom 
Sizes and create a custom size that is 22 inches wide. The other settings are immaterial 
for now. After applying the new style, set tabs so that each column is isolated, i.e., no 
column intrudes into another column. Reducing the font size can be helpful because 
readability is not important at this stage. When the columns are isolated, you may notice 
that every element with a comma has quotes around it. These were added during the 
export process to distinguish commas in text from the commas that are used to separate 
the columns. We’re now using tabs to separate the columns so we can get rid of the 
quotes by using Word’s Find and Replace function. 
Select All then Edit > Find > Replace, then using Word’s symbol for tab (^t), Find ^t” 
(tab, quote) and replace all with ^t (dropping the open “). Follow this up with Find “^t 
(quote, tab) and replace all with ^t (dropping the close “). Now we are ready to apply one 
of the best kept secrets in Word—the vertical block. 
Place the cursor in front of the first artist’s name, hold down the Option (Alt) key and 
drag the cursor down to be in front of the last City_State item; do not capture any part of 
the City_State2 column. When the artist column is selected, you can apply a font style; in 
our case bold. Note: In some cases, the number of rows that can be selected as a vertical 
block is limited and you may need to select the column incrementally. In our setup, 
we’ve had success selecting 40 rows at a time. When you’re done with the artists, use a 
vertical block to select the Title column and style it italic. 
What happens next depends on how you want to format the catalog. We’ll use the same 
format we used when merging. 
To eliminate the tab between the artist and the city-state, we again use Find & Replace to 
Find: tab, space, space, open parentheses and Replace it with: space, space, open 
parentheses, dropping the tab. Next we replace all tabs in the document with a new line, 
(caret lower case L:   ^l). Doing that placed the number on a line above the artist’s name. 
Now we’ll use the decimals we added earlier to correct that by Find period, 00, new line 
(.00^l) and Replace with period, tab (.^t). This places the number on the same line as the 
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artist’s name. If the tab is not needed, we could have replaced it with a space during the 
Find & Replace. 
You can see that the two added decimals simply served as a marker to distinguish that 
new line from the others on the page. This illustrates an important and powerful point. 
We can creatively use Excel’s CONCAT function to add markers in the Excel or csv file 
to support our formatting the catalog using Word’s Find & Replace functions. For 
example, instead of the two decimals, we could have added .q@# to the number and 
achieved the same purpose as we did with the decimals. If we wanted to use the last name 
in bold, followed by a comma space and the first and middle names, we could re-order 
the name columns in Excel and put distinct markers after the last name and first name 
using CONCAT. Those markers could be used in Word to insert a comma and space after 
the last name and a space after the first name during the preparation of the catalog. The 
aim of this section of the appendix is not to show how to format the catalog; it is to show 
how you can format it pretty much any way you like by processing the downloaded data 
creatively using the tools available in spreadsheet, word processing and page layout 
applications. 
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APPENDIX C 
PAYPAL SETTINGS 

The full benefit of Easy Entry Online is available only if the PayPal account has been set 
up appropriately and the required PayPal information is entered into the client setup form. 
The details in this guide relate to the PayPal interface in use currently. If your PayPal 
interface seems inconsistent with this guidance, please let us know by email or phone. 
You must set your PayPal account for PDT and IPN to record entry fees. If you will offer 
artwork for sale online, the additional sections below are either necessary or pertinent. 
 
Setting PayPal for PDT and IPN — required to auto-record entry fees. 
After logging in to your PayPal account, click on the gear-shaped icon in the upper right 
and select Account Settings. On the Account Settings page, look in the sidebar for 
BUSINESS PROFILE and select Business information to make a note of your PayPal 
Merchant ID, one of three things you need to enter in client setup. Then, under 
PRODUCTS & SERVICES, select Website Payments to see a list of choices.  
Click the update link for Website preferences: Bring customers back to my website after 
they pay with PayPal. On the Website Payments Preferences page, do the following: 

1. Auto Return must be turned On and a return URL must be entered. If you use a 
return URL for some other purpose, you may keep it; the Easy Entry payment 
process will ignore it for entry fee and purchase payments. If you do not use it for 
other purposes, please enter: http://easyentryonline.com/altreturn.php and click 
Save.  

2. Payment Data Transfer (PDT) must be turned On. IMPORTANT:  Carefully copy 
and retain the PDT Identity Token (no terminal spaces) to later paste into client 
setup 

3. PayPal Account Optional should be turned On. This allows payers without a 
PayPal account to pay with a credit card. All other settings on this page should be 
Off or No unless you have a specific reason for a different setting.  

Select “Back to Profile” at the upper left and select the Update link opposite Instant 
payment notifications. Depending on whether IPN has already been enabled, you should 
click on either Choose IPN Settings or Edit settings, either of which will take you to the 
IPN settings page. 
Here you must enable Receive IPN Messages. If you are already using IPN, you can leave 
your URL in place. If you are not using IPN, please enter 
http://easyentryonline.com /altnotify.php 
as this has the potential for providing useful information when an entrant has not used the 
correct process for a fee payment. Click Save before leaving that page. 
You are now ready to enter your PayPal primary email address, business ID and PDT 
Token in the client setup page. 
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NOTE: When IPN is enabled, clicking on the Update link next to Instant Payment 
Notifications displays the current settings and, in the text above, a link to the IPN History 
page. IPN messages are normally not viewed; they are sent to an IPN receiver for 
automatic updating of a related database. For all Easy Entry payments, the IPN is sent to 
an Easy Entry IPN listener for updating your payment records. However, the IPN 
messages are stored for 28 days and can be retrieved from the IPN History during that 
period. If anomalies in the payment process occur, reviewing the related IPN messages 
can be very helpful in finding out what happened. 
 
Setting State Sales Tax Rate for Sales 
After logging in to your PayPal account, click on the gear-shaped icon in the upper right 
and select Account Settings. Then in the sidebar under Account Settings, look for 
ACCOUNT & SECURITY and select Payment Preferences to see the Sales Tax option. 
Select your state and enter the sales tax rate as a percentage and Save. (If you have a 
physical presence in multiple states, you might need multiple PayPal and Easy Entry 
Online client accounts.) 
Setting the sales tax this way only affects artwork sales. Easy Entry is not aware of any 
state that imposes sales tax on entry fees and our exchanges with PayPal are such that tax 
is never collected by PayPal on entry fees. However, the tax profile of states can change. 
If your state requires collection of a tax on entry fees, please notify Easy Entry to see if 
we can accommodate that requirement. In the meantime, you would need to include the 
tax in the entry fee. 
 
Ship Only to Confirmed Addresses 
Also on the Account Settings page under ACCOUNT & SECURITY, select Payment 
Preferences to update the Block Payments option where you can choose to block various 
payments. Easy Entry recommends two in particular: Block accidental payments and For 
the items not sold on eBay, only allow payments from customers with confirmed 
addresses. Easy Entry Online is designed to prevent multiple payments so Block 
accidental payments is simply added insurance. Requiring confirmed addresses deserves 
more explanation: It limits shipping to the address associated with the credit card or 
PayPal account. This is intended to protect against unauthorized use of a credit card. 
Although it means that artwork intended as a gift has to be received by the buyer before 
sending it to a third party, this negative does not, in Easy Entry’s opinion, outweigh the 
additional security provided by confirmed addresses. Additional information regarding 
PayPal’s seller protection can be seen at: 
https://www.paypal.com/us/webapps/mpp/security/seller-protection 
 
Setting Shipping Charges for Individual States or Regions 
The PayPal options for shipping calculations provide more flexibility than Easy Entry 
Online can accommodate within its system. Setting up different regions with non-
overlapping sets of states and territories seems straightforward, but any broader use 

https://www.paypal.com/us/webapps/mpp/security/seller-protection
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requires some creativity and more details than Easy Entry can provide. We can help you 
to find the options but must leave it to you to decide how to use them.   
Still on the Account settings page, in the sidebar under PRODUCTS & SERVICES, 
select Shipping, then Shipping Calculations to see the default Domestic Shipping 
Methods, which is likely to be marked Free Shipping in the second column and Active in 
the last column. If you are going to set shipping charges for individual or groups of states, 
you could delete this method but the better choice might be to make it inactive by 
checking the box in column 1 and selecting Edit. 
By selecting Add Another Shipping Method, you can select individual or groups of states 
and set the charges applicable to each artwork shipped to those destinations. Easy Entry 
will send the number of artworks; the confirmed address determines the destination.  
 
 
 
If you need additional help setting up your PayPal account, please contact: 
support@easyentryonline.com 

Include your phone number and the nature of your problem. 
  

mailto:support@easyentryonline.com


34 

 

 FIGURES 
 
Client Setup Form Parts 1 – 3 33 

Event Setup Forms Parts 1 – 3 36 

Event Manage Forms Parts 1 – 5 39 

Artwork Entry 45 

Juror Display — Individual Artwork 46 

Admin Accept Individual Artwork 47 

Admin Accept Groups 48 

Juror Display — Body of Work 49 

Admin Accept — Body of Work 50 

On-Site Sales Catalog 51 

On-Site Sales Form 52 

On-Site Sales Receipt 53 

Gallery A — Viewing or Sales 54 

Gallery A — Online Sales Form 55 

Gallery B — Viewing or Sales 56 

Gallery B — Online Sales Form 57 

Gallery B — Online Sales Receipt 58 

   



35 

CLIENT SETUP FORM Pt 1 

 
Figure 1.1  
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CLIENT SETUP FORM Pt 2 

 
Figure 1.2  
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CLIENT SETUP FORM Pt 3 

 
Figure 1.3 RETURN  



38 

EVENT SETUP FORMS Pt 1 

 
Figure 2.1  
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EVENT SETUP FORMS Pt 2 

 
Figure 2.2  
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EVENT SETUP FORMS Pt 3 
Change Event Date(s) and Get List of Event Number are not displayed. 

 
Figure 3.3 RETURN  
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EVENT MANAGE FORMS Pt 1 
 

 
Figure 3.1  
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EVENT MANAGE FORMS Pt 2 

 
Figure 3.2  
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EVENT MANAGE FORMS Pt 3 

 
Figure 3.3  
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EVENT MANAGE FORMS Pt 4 

 
Figure 3.4  
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EVENT MANAGE FORMS Pt 5 

 
Figure 3.5  
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EVENT MANAGE FORMS Pt 6 

 
Figure 3.6 RETURN 
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ARTWORK ENTRY 

 
Figure 4 RETURN 
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JUROR DISPLAY — INDIVIDUAL ARTWORK 
 

 
 
Figure 5.1 RETURN 
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ADMIN ACCEPT INDIVIDUAL ARTWORK 
 

 
 
Figure 5.2 
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ADMIN ACCEPT GROUP 

 
 
Figure 5.3 RETURN  
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JUROR DISPLAY — BODY OF WORK 

 
Figure 6.1 RETURN 
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ADMIN ACCEPT — BODY OF WORK 

 
Figure 6.2 RETURN 
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ON-SITE SALES CATALOG 
 

 
 
Figure 7.1 RETURN 
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ON-SITE SALE FORM 
 

 
Figure 7.2 
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ON-SITE SALE RECEIPT 

 

 
Figure 7.3 
  



56 

 
GALLERY A — VIEWING OR SALES 

 
Figure 8.1 Differs for viewing only.  
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GALLERY A — ONLINE SALES FORM 

 
 
Figure 8.2 RETURN 
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GALLERY B — VIEWING OR SALES 

 
Figure 9.1 Differs for viewing only. 
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GALLERY B — ONLINE SALES FORM 

 
Figure 9.2  
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GALLERY B — ONLINE SALE RECEIPT 

 
Figure 9.3 
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